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Requirements 

 

Requirement 01 
Access to SAP Ariba Shared Partner Demo realm 
http://Cumulonimbus-t.procurement.ariba.com/ 

- If you do not have an access to shared demo realm please contact your PSA. To identify who 
is you PSA (Partner Service Advisor), please look on 
page: https://partneredge.sap.com/en/partnership/manage/benefits/psa.html  

 
Access to Ariba Network 
http://supplier.ariba.com 
 

 

Requirement 02 
 
User ID and Password for Demo realm as and end user.  
The SAP Ariba Shared Partner Demo site is available to SAP Ariba authorized partner only. To request 
new access to the shared demo site, contact your PSA (Partner Service Advisor). To identify your PSA: 
https://partneredge.sap.com/en/partnership/manage/benefits/psa.html 
 
URL to get details of supplier credentials to process RFP, purchase orders etc. 
https://jam2.sapjam.com/blogs/show/qt4LMxdPQ20TJaTs8beE0L 
  
URL to get Supervisor credentials to approve purchase requisition  
https://jam2.sapjam.com/blogs/show/qt4LMxdPQ20TJaTs8beE0L 

 

 

http://cumulonimbus-t.procurement.ariba.com/
https://partneredge.sap.com/en/partnership/manage/benefits/psa.html
https://partneredge.sap.com/en/partnership/manage/benefits/psa.html
https://jam2.sapjam.com/blogs/show/qt4LMxdPQ20TJaTs8beE0L
https://jam2.sapjam.com/blogs/show/qt4LMxdPQ20TJaTs8beE0L
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Enhanced Contract Authoring 
Step 01 Login 

 

 
 
Go to  
http://Cumulonimbus-t.procurement.ariba.com/ 
 
And Log-in using your Demo user ID (your company email id) and password. 
 
 

 

Step 02 Enabling Enhanced Contract Authoring 
     
This feature is disabled by default. To enable this feature, please have your Designated Support 
Contact log a service request. A SAP Ariba Customer Support representative will follow up to 
complete the request. If you enable this feature, you will be redirected to the new contract authoring 
workflow with drag-and-drop document imports, seamless editing, and simplified clause management. 
 

 
 

Overview of enhanced contract authoring features: 
SAP Ariba provides enhanced contract authoring with drag-and-drop document imports, seamless 
editing, and simplified clause management. The enhanced contract authoring workflow provides a 
simplified, intuitive, platform-independent interface while eliminating many of the limitations inherent in 
the previous workflow. The enhanced contract authoring features are not supported for Ariba Contract 
Management Basic users. Following are the highlights of this enhanced interface:  

• Open-XML based, bookmark-free document formatting Previously, you needed to add bookmarks 
to your contract documents (main agreement and contract addendums) to identify clause 
boundaries. Now, you can format documents using any Open-XML based editor and use document 
styles to identify clause boundaries.  

• Drag-and-drop document imports Previously, you needed to create a Desktop File Sync (DFS) 
folder on your system and periodically sync document updates from the local folder to the server. 
Now, you only need to drag-and-drop documents directly into the application, and your dropped 
files are automatically available on the server.  

• Simple, in-application redlining and editing Previously, comparing and merging contents of main 
agreements after internal or external edits invoked an external application with a three-way merge 

http://cumulonimbus-t.procurement.ariba.com/


 

4 
 

window. Now, the three-way merge window is replaced with a simple in-application redlining view 
that allows you to view and document changes quickly.  

• Server-side document assembling and generation with no Desktop File Sync (DFS) or dependency 
on the Internet Explorer browser. The use of DFS in the previous contract authoring workflow 
required ActiveX controls, which presented security vulnerabilities and required Internet Explorer. 
Since DFS and ActiveX are no longer used, you are free to use a variety of browsers. 
 

For more details please refer to SAP Ariba Product Documentation: “Enhanced contract authoring” 
 

 

Create a Contract Request 
 

Step 04 Create a Contract Request  

 

 
 

The first process that can be implemented with SAP Ariba Contract. 
Solutions is that in order to create a contract workspace, the need for a contract is requested by the 
end users through the functionality “Contract Request” – there’s no license behind this feature, so it 
can be used by any person in the customer’s  
organization. 
1. Using the main “Create” blue button, use the option “Contract Request (Procurement)” to create a 
new request. 

Note: A requester can create a contract request which will be sent for approval. Once the 
request has been reviewed and approved, the contract team can take the request further. This 
ensures that contract team only comes into the loop when the request has been approved. 
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Step 05 Create a Contract Request 

 
 

1. The Create Contract Request Overview screen will be displayed. 
2. Enter Name: Demo User X – Agreement Request – Today’s Date 
3. Provide a Description 
4. Enter the necessary dates, such as Agreement Date: today | Effective Date:  today | 

Expiration Date: next year. 
i. Term Type may remain Fixed. Enter a Notice Period. 

 

 
5. Select the “Demo Contract Request Template” and click “Create”. 
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Step 06 Review contract request 

 

 
 

1. Your new Contract Request is displayed. Please review the information provided in the 
Overview, Contract Attributes, Contract Term Attributes, Tasks and Documents. 

2. You may also select to view space in “Compact View” by clicking on the Actions menu in the 
Overview window and selecting Compact View. 
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Step 08 Complete Tasks 

 
 

 
 

 
1. Administrators of the system (or template managers such as partners) can configure dynamic 

approval flows based on the request submitted, contract attributes, processes, etc. This 
template includes an approval task so that the Contract Manager group is notified of a new 
request. We’re going to start that approval process Click on the icon of the Approval for 
Contract Request on task, and then on the “View Task Details” link. 
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Step 09 Complete Tasks 

  

1. Provide a Due Date 
2. Include a message for the approval. 
3. Click on the Approval Flow tab. Note a Contract Manager is indicated; however the system 

allows requesters to pull in additional approvers if needed. If you click on the arrow before or 
after the Contract Manager, you can add more approver if necessary. 

4. Finally click Submit to start the approval flow and notify the approvers. 
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5. If you View Task Details” link again you will see the workflow approval and also who is going to 

approve it. 
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Step 10 Complete Tasks 

 
 
 
 
 
 

To approve the request, you can approve it using your own user, but you could also log in as an 
approver part of the Contract Manager group; in this case, user “Supervisor User” – see login details in 
‘Requirements 02”: Click on the title of the Approval for Contract Request task, and from the Action 
menu, select Approve. (Please note it may take a few moments for the Approve link to appear. Press 
F5 to refresh the application.) 
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On the next screen confirm the approval by clicking OK. 
 

 
1. Logout as a Supervisor. 
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Initiate Contract Workspace from Contract Request 
  

Step 11 Initiate Contract Workspace from Contract Request 

 
 
 

1. Login with your user and open the contract request.  
2. From the “Contract Attributes” section, we can now see that the Process has been approved 
3. In the Documents section, we can now see that a Contract placeholder is now visible – this is 

due to the fact that template was conditioned to only show that document when the process is 
approved. (Wait for a few moments and press F5 to refresh if the Contract document does not 
appear).Click on the Contract document, and then on the link “Open” 
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4. An Overview screen will appear to create the contract, and you can verify that the header 
fields have already been auto-populated from the Contract Request. You could then modify the 
title and complete the selected fields in red box. 

 

 
5. Scroll down and select the template and create the contract from here. 
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Collaborate on a Contract Workspace 
 

Step 12 Review Contract Workspace 

 

 
 

1. After clicking on the “Create” button, the system uses the contents of the template to generate 
the contract documents; one this is done, then the new Contract Workspace is displayed. 

2. Note that the contract workspace is shown using the Compact View – you can keep that view 
or click on the Actions button and display the “Full View” to see the different tabs available.  

3. You can also notice that the assembled document called “Main Agreement” is in “Draft” 
mode, which means that the template has already creating a first draft of the document that 
can be used as base for the contract. 
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Step 13 Review Contract Workspace 

 
 

1. Note the tabs which organize the different areas of the Contract Workspace.  

• The Overview tab provides a summary of the project. Take a moment to review the 
information on the Overview tab and click on the other tabs. 

• The Documents tab contains the Main Agreement as well as additional document i.e. 
Schedule related to the agreement. 

• The Tasks follow contract creation process within an organization and provide steps. The 
Team tab grants individuals access to a Contract Workspace. Access can be limited 
based on permissions, roles and groups. 

• The History tab provides a detailed activity log within the individual workspace. 
2. From the Overview tab Click Actions, then select Edit Overview. 

 

 

 

Step 13 Review Contract Workspace 

 

 
 

1. Click on the Template Questions tab. Note that you can change these answers to alter the 
workspace. Don’t change the answer.  Return to the Overview tab. 
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2. Note that the Contract Workspace is assigned an Owner. 
3. Click the Access Control drop-down menu arrow, then click Search for more… 

• Note the different security options. This is just one of the ways that access to contracts 
can be controlled. Click Done. 

4. Click Cancel on the Edit screen 

 

Note: the History tab. The History tab tracks changes or activities, such as attribute changes or actions 
on documents, providing visibility who did what and when within a project. This feature searches the 
database log to monitor user login activities and actions and is particularly useful for tracking edits and 
approvals of changes 
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Step 14 Select Team Members 

 
 

 
 
 

1. By clicking on the Tasks tab, you can have a look at the process set-up in this template, and 
you can see that the first task is to update the team members of this contract 

2. Go the Team tab, review the project groups defined at the template level, and click on the blue 
“Actions” button, and then select Edit. 

3. To the project group “Contract Manager”, you can add your own user to those groups. 
For the category manager and Business Unit, click on the drop-down, and then click on Search 
more…, search for “Supervisor User” and select the user called “Supervisor User (Ariba-SAP)” to 
add it to the project Group. 
Click the blue “OK” button once finished. 

 

 

 

 

 

 

 

 

 

 



 

19 
 

Step 15 Select Team Members 

 
 

 
 

1. Click on the Tasks tab then on the “Update Team Members” task and select Mark 
Complete from the pop-up. 

2. The task is now complete, and a blue check mark is displayed. 
3. Now, extend the following Phase called “Negotiation and Review”; the first task is 

“Internal Review for Main Agreement”, and a document called “Main Agreement” is 
associated to it.  Click on the “Main Agreement” link, and from the menu, choose View 
Details. 

 
SH, aqui 

Step 16 Draft and Review internally Agreement 
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1. The document is parsed into clauses, allowing you to perform several actions such as 

highlighting non-standard clauses, editing, substituting, viewing clause versions, etc. 
2. Scroll down within the “Terms” clause. Click on the “Actions button” and then 

“Substitute” option to access the clause library. 
3. Once in the library, use the radio buttons to choose either an alternate clause you wish to 

use and then click OK. Optionally, a comment may be entered as well. 

 
 

Step 17 Draft the Main Agreement 
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1. Click the Main Agreement link to the right of the task title and select Download Draft to 
open the document in Microsoft Word. If you are prompted to update fields in the 
document, click Yes. 

2. In order to keep track of any changes made to the document, make sure that ‘Track 
Changes’ functionality is turned on in Microsoft Word. When it’s on, the changes are red-
lined. (Track Changes can be turned on from the Review tab in Microsoft Word.) 

3. Make sure that you turn off field codes so you can see the supplier’s name and address in 
the contract document.  
a. Click File > Options > Advanced  
b. Scroll to Show Document Content  
c. Show Field codes instead of their Values should be UN-CHECKED  
d. Field Shading should be set to Always. Click OK to return. 

Note: Into the Word document from the Contract Workspace. 
4. Modify the agreement: In the Services section, change the text of the first sentence by 

replacing “shall” with “will.” Note how the document is redlined to reflect the changes. 
5. Once you are done editing, save the document on your computer in a location where you can 

locate it easily. Close the document. 
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Step 18 Draft the Main Agreement 

  

 

  
 

1. Return to the Contract Workspace in SAP Ariba.  
a. Click on the Main Agreement and click View Details  
b. Drag and drop the document from the folder to the box in the system  
c. At the top of the page a message reads “A new document has been uploaded: What do 
you want to do?”, Click on What do you want to do? And choose Review uploaded 
document.  
d. On the next page you can review the changes in CW.  

On the subsequent screen, click on Process All Changes, save this as a new version and enter a 
comment describing your change and click Save. 
2. Click on the Main Agreement link and select View Details. Select Nonstandard for the 

Clause Type (drop down towards the top of the screen). You should see the clause that you 
manually edited. 

3. Scroll down the list of clauses until you get to the section labeled Governing Law. Click the 
ALT icon. The system will take you to the Clause Library and display any clauses that serve as 
an alternate to the current clause. Select the alternate clause and click OK. Back in the 
Outline View, notice the clause type changed from Template to Library. Minimize your 
browser. 
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Step 19 Draft the Main Agreement 

  

 
 
 

1. AdHocClause.docx. Close Microsoft Word. 
2. Return to the Outline View of the Main Agreement in your browser and add your new clause:  

a. Click on the Arbitration section and select Add Clause(s)  
b. Click on the Custom Clause tab and drop the AdHocClause document you just created 
into the dashed boxed  
c. Click OK 

3. Back in the Outline View, scroll to the Arbitration section and verify that your new clause has 
been added.  

4. Click Done to return to the contract workspace. 
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Step 20 Review the Main Agreement 

 
  

1. Go back to the Tasks tab and notice that the next task to be completed is “Internal 
Review for Main Agreement”. So, we need to send the current document for review 
to the team members. 

2. Click on the task name, and then on “View Task Details” 
3. Specify the due date for the Review and click on the Review Flow to see who’ll be 

involved with the review. Click the “Submit” blue button. 
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Step 21 Draft and Review internally Agreement 
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1. As your user is responsible for Legal and Business Unit, you can click on “Complete 
Review” from the task name since it was already drafted. On the confirmation screen, just 
click “OK” 

2. Now log out and log in as the Supervisor User; see ‘Requirements 02’ for credentials. Go 
to the “Contracts Dashboard” and from the “My tasks” list, click on the “Review for Main 
Agreement” task. Or go to Manage>My tasks and find your review request. 

3. Another way is to find the request with Contract Workspace Id. 

 
 
 

Step 22 Draft and Review internally Agreement 
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1. The Supervisor User can now Download Draft of the Main Agreement document and 
review it. You can do any change you’d like to the document, and once done, you can 
upload that changed version;  

2. Back in the SAP Ariba site (you should still see the open Review task):  
a. Click the Complete Review button  
b. Input a message of your choice back to the contract owner  
c. Drag and drop the Main Agreement that you just edited into SAP Ariba (optional) 
d. Click OK  
e. Log out of SAP Ariba as Supervisor User. 

 

 
 
 
 

Step 23 Draft and Review internally Agreement 
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1. Now that every team member has completed the review, the task owner can finally take in 
consideration all the comments and can finally complete the task. Login again as your own 
user, navigate to the contract workspace and then to the Tasks tab. From there, click on 
the name of the task “Internal Review for Main Agreement”, and then View details.  

2. You can notice the status of the task which is now “Awaiting Owner Actions”. 2 buttons 
are available: 
• New Round: Either another round of reviews if you decide to create a 
new version of the Main Agreement and go through revision again  
• Mark complete: if you have received enough information from the 
team members and your document is ready to be sent to the supplier for negotiation 

3. You can see in the Task History tab of the task all the documents and proposals from the 
team members that have reviewed the main agreement and sent counter-proposals. 
Click on the link “Review changes” to see what kind of changes are proposing your team 
members. 

4. After the document opens in SAP Ariba, review the changes using the Next and Previous 
buttons to navigate the changes. Click Process All Changes. 

5. On the subsequent screen, save as a new version and enter the comment “Reviewer’s 
Redlines”. Click Save. 

6. Mark the Internal Review task complete. 

 
 
 
 
 
 
 

Step 24 Negotiate Agreement 
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1. Click on the “Supplier Negotiations” task, and select the option “View Task Details” 
2. In order to launch the negotiation, it is necessary to indicate a reviewer to the task. You can 

select from the supplier users already in the system or invite a new external reviewer by 
clicking the associated link. (optional) 

3. If the contract is for “LanSoft.”, then click on the dropdown, and then “Search more…”, search 

for “LanSoft”, and select the user with ID users@lansoft.com. For Supplier Negotiation task, 
select the supplier user ‘Lansoft Technologies’ with ‘standardaccntgmail.com’. Use the below 
one: 

4. After selecting the supplier user we have to negotiate the contract with, you can select a review 
date, and also you need to indicate an initial message as it is mandatory. 

5. Click on the blue button “Submit”. Once you’re back to the project tasks tab, you can log out; 
or open a new browser as you’re going to review the document as the supplier in the next step. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:users@lansoft.com
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Step 25 Negotiate Agreement 

   

 
1. Go to the following URL: http://supplier.ariba.com. Enter the system using the supplier 

credentials (if you’re using “LanSoft”, then use users@lansoft.com - see all credentials on 
‘Requirements 02’ section) and then “login”. 

2. From the supplier view, click on the tiles icon, and select “Contracts”; then make sure, you’re 
viewing content for customer “CUMULONIMBUS – TEST” and wait for the main content of the 
page to be loaded. 

 
 

Step 26 Negotiate Agreement 

 

 

http://supplier.ariba.com/
mailto:users@lansoft.com
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1. In the list of tasks presented in the summary table, locate your project, and click on the task 

call “Supplier Negotiation” 
2. Supplier can download the document to review it; open it and see how the document is clean 

from internal comments. Then the system gives two options to the supplier: 
• Create counter proposal: in this case, the supplier is invited to load a new version of the 
main agreement and send it to the buyer. Click “OK” on the confirmation screen. (select this 
one) 
• Accept Proposal: accept formally the proposal from the customer. For this demo, just click 
on the “Accept Proposal” button to move to the signature part of the process.  
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Step 27 Negotiate Agreement 
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1. Go back to the Ariba Contracts platform and log in with your user. From the dashboard, enter 
the contract workspace. Click on the Supplier Negotiations task, and “View Task Details” 

2. Go to the MainAgreement document and select Review Change 
3. Here you can see all changes and feedbacks then select Process All Changes 
4. Save as a new version 
5. You can see the answer from the supplier – in this case he create a counter proposal– so 

you can now “Mark Complete” this negotiation task. 
6. Complete to save all changes 
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Step 28 Approval and Final contract generation 

 
 

 
 

1. Now, the phase “Negotiation and Review” is finished, we enter the Approve and Finalize 
phase. The first task is the internal approval of this contract.  

2. Click on the tasks tab, click on the task “Approval for Contract Documents” and then “View 
Task Details”. 
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3. You’ll be able to submit the document for approval. You can have a look at the approval flow 
from the bottom of the screen. Indicate a due date, a comment if necessary, and then click on 
the “Submit” button. 

4. Logout with your user. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 29 Approval and Final contract generation  

 

 
 



 

36 
 

 
1. Log in as the approver; user “Supervisor User” – for credentials please refer to 

“Requirements 02”. From the Contracts tab, access the My tasks list, and you should see the 
waiting tasks to be approved. If you don’t see your task, click on the link “View all” to search 
through all the tasks. Or you can search it with Contract workspace ID. 

2. In an approval task, the approver has 2 options: 
• Deny: if the approver doesn’t agree with the document, he can deny the task, and send it 
back to the owner of the contract for review. 
• Approve: if the approver is OK with this agreement, he can approve it; the task being 
approved will change the status of the whole workspace and mark as it “Approved” 

Click on the “Approve” button, and then “OK” in the confirmation screen. Once back at the dashboard, 
log out, and log in again as your user so that the contract can be signed. 

 
Note: At this stage you can use DocuSign.  

  
 

Step 30 Electronic Signature using DocuSign® 
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Log out from the application, and log in again using the user “DemoCFO”. Go to the “Contracts” tab of 
the dashboard, and search for your Contract. 

1. From the search results, open the Contract Workspace. In the Tasks tab, you can see that the 
approval task is now complete, and the Signature task has, as owner, the group Legal for 
which DemoCFO is the main user. You need to be the owner -of this task to send the 
document for signature. Click on the task, called “Signature for Final Contract”, and then 
“View Task Details”. 

2. A Popup will appear so that you can select which Digital Signature provider to use: Select the 
“Docusign” option and then OK. 

3. In the customer organizations, this task will be set-up so that a few numbers of persons can 
actually sign the contract – we’ve left it open for demo purposes. Click on “New Email Signer” 
and create a new email signer; use an email address that you can access. 
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4. The system will ask for data in order to provide DocuSign with information regarding the email 
signer. Mandatory is the Name and Email. Please fill-in the mandatory fields, and click “OK” 

5. Note at the bottom of the screen where the signed document will be stored. Indicate a due 
date, and then click on “Submit” to send this document to signature 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 31 Electronic Signature using DocuSign® 
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1. The system will direct you to the DocuSign web site where you’ll be able to visualize the PDF 
version of the contract and where you’ll be able to specify what kind of signatures or fields you 
want to have in the document and that the signer will have to fill. 

2. To do a simple demo, drag and drop an “Initial” box on the first page, and a Signature on the 
last page of the contract. 

3. Finally, “Send” the document to the signer. 
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Step 32 Electronic Signature using DocuSign® 
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1. Open the email Inbox you’ve specified when creating an external email reviewer- you should 
have received an email that looks like the following. 

2. Click on “Review Document”. This will take you again to the DocuSign site. Click on the 
“continue” button. 

3. There DocuSign will guide you in the signing process of the document. Just use the orange 
buttons, like the Start one. 

4. Add your initials to your profile and to the document, and then sign the last page of the 
document. 

5. When all done, just click the “Finish” button. 
6. You will receive the final version on your email inbox. 
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Step 33 Electronic Signature using DocuSign® 

 

 
 
 

1. Let’s go back to the Ariba Contracts Application as the user “DemoCFO”. From the “Recently 
Viewed” box, click on the contract you just signed. 

2. Click on the “Signature” task”, and then “View Details”. 
3. This time select the “Properties” tab of the task. An “Actions” button is available, click on it, 

and then on “Refresh Status”. 
4. The page will refresh, and you’ll see that the status of the task is now “Signed”, and that the 

document is being downloaded 
5. Click on the “Exit” button, and then log out from the user “DemoCFO” in order to log in again 

using your own user. 
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Step 34 Publish Agreement 

 
 
 
 

 
1. The last task in the workspace is to “Finalize and Publish – so click on the task and mark as 

“Complete” 
2. Go back to the Overview tab on the Contract Workspace, and in the Contract Attributes 

section, click on the Actions button. Then click Publish. 
This will change the status of the contract to “Published”, and therefore the contract is open 
for its execution. 
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Review Amendment Types 
Step 35 Review Amendment Types 

 

 
 

1. Your Contract Workspace is now published. Once a contract is open and in execution, it 
cannot be changed easily, as any change would need to be communicated to all parties that 
have signed the contract. Only option is to create amendments. 

2. In Contract Attributes section, click on the Amend option to view the amendment types. 
3. Also note that other options are available: 

- Put On Hold: in order to suspend an active contract. 
- Close: in order to close a contract before its expiration. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

47 
 

Step 36 Review Amendment Types 

 
1. The solution offers four Amendment Types: 

-Renewal: Allows you to change the effective date, expiration date, and reminder settings. 
- Amendment: Allows you to change any part of the contract workspace. If you change a 
document associated with a task which has Repeat for Each Draft selected, Contract 
Management reactivates the task. 
- Administrative: Allows you to change non-contract details, such as adding a team member 
or uploading a supplemental document or changing a description field. This type of change 
does not create a new version of the contract workspace. The Published status is kept. 
- Termination: Allows you to change the expiration date and reminder settings. Use this 
amendment type to close a contract before its expiration date due to an adverse condition or 
disagreement. 
Note: Depending on your Contract Management implementation, you might have additional 
fields for each amendment type. 

2. After review, click Cancel to exit out of Amend Contract Workspace option. 
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Contract Workspace Search 
Step 37 Contract Workspace Search 

 
 
 

1. From the Contracts tab, you have access to the search tool –Make sure that the type of 
document you’re searching is “Contract Workspace (Procurement)”.If it isn’t, click on the 
drop-down menu and select it. Once it’s selected, you can type any text you want to search 
within your contract workspaces. The system will look for a match in all metadata fields of the 
Contract (title, id, etc..) but also will run a full text search within the contracts documents. 

 

Step 38 Contract Workspace Search 

 

 
 

1. Using the keywords you’ve entered, the system takes you to the search screen with the first 
results of your search. 

2. You can now refine your search by adding new filters (Title, Commodity, etc..) 
3. You can save your searches for future uses. 
4. From the results table, you can add or remove some result columns if necessary.  
5. Click the Home tab to return to the Dashboard. 
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Clause Search 
Step 39 Clause Search 

 

 
 

1. To search clauses, the process is very similar to the Contract search. From the Contracts tab, 
go to the search tool, click on the drop-down menu and select “Clause Library”. Then a type a 
text from a clause, and finally on the “search” icon. 

2. In the results page, you can click on the title of any the clause found, and then click on the 
“Search Where Used” link for the system do display all the contracts where this clause is 
being/has been used. 
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Step 40 Clause Search 

 

 
 

The contracts with the searched clause are now displayed. 

 
 


